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Mailing Forms

       
In this chapter:
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■   The Send Command   10-3
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10Mailing Forms
Many types of forms must be sent from person to person for approval and processing purpos
example, it’s very common for a purchase requisition form to be filled out by the requestor, s
a supervisor for approval, and then forwarded on to the purchasing department. In large orga
tions, a single form might go through several levels of approval before the process is comple

Through the use of Informed mail plug-ins, Informed Filler connects directly to various electro
mail systems, making it easy for you to send completed forms right from within the Informed F
environment. With plug-ins, Shana can easily support new e-mail systems by simply impleme
new mail plug-ins.

For details of the specific e-mail systems supported by Informed Filler, see the “Mail Plug-ins
topic in Informed Filler’s on-line help system.

Most e-mail systems allow you to attach a file to a message so that it is included with the me
when sent to the recipient. When you send a form using Informed Filler’s Send command, 
Informed Filler automatically creates a file containing the record, or records, you want to send
attaches the file to an e-mail message and sends it to the recipient.

The form designer can pre-configure a list of suggested routes for a form template. Suggeste
routes are intended to provide guidance regarding the person or place that you might send a f
You can send a form to a suggested route, or you can manually address a form to any perso
place you like.

Mail Preferences
As mentioned previously, Informed Filler can send forms using a variety of different e-mail sy
tems. You can use Informed Filler’s Preferences command to specify your preferred mail syst
that you’re not asked to select which one each time you send a form.

To specify your preferred mail system, choose Preferences... from the Edit menu. When the Pref
erences dialog box appears, click the Mail icon in the scrolling list. The dialog box changes to
the Mail Preferences panel.

Mail Preferences



 

Mailing Forms 10-3

 .
 .

 .

 

e 
ct a 

m 
r more 

    

s 
ou 
tem to 

nd 
n 

 

.

Click the ‘Mail service’ drop-down list and make a selection from the available choices. The 
choices in the ‘Mail Service’ drop-down list correspond to the Informed mail plug-ins you hav
installed in your plug-ins folder. If you select the ‘User’s choice’ option, you’ll be asked to sele
mail system each time you send a form.

The ‘Suggested Routes...’ button allows you to define your own suggested routes for your for
templates. See “Adding, Changing, and Removing Suggested Routes” later in this chapter fo
information.

The Send Command
To mail one or more records, choose Send... from the File menu. If there are no suggested route
for the template you’re using, your plug-ins folder contains more than one mail plug-in, and y
have not previously specified your preferred mail system, you’ll be asked to select a mail sys
use.

Select a mail system from the ‘Send using’ drop-down list and click ‘OK.’ The subsequent Se
dialog that appears and the corresponding method of selecting recipients varies depending o
which mail system you use. The following example shows the Send dialog box for Microsoft 
Exchange.

The Send Command
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You can select which records to send by choosing an option from the ‘Send’ drop-down list. I
form window is active when you choose the Send command, the options include ‘Current rec
and ‘Collected records.’ When the Record List is active, you can select from the ‘Current reco
‘Entire Record List,’ or ‘Selected records’ options.

You specify one or more recipients using the method that corresponds to the mail system yo
using. You can also enter a subject and choose the format in which to send the record or rec
The following table lists the data formats available in the ‘Send As’ drop-down list and gives a
description of when you would use each one.
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Data Formats

The form designer can lock the data format to prevent you from accidentally choosing an inc
setting. If the data format has been locked, you will not be able to select a different format fro
‘Send as’ drop-down list.

Once you’ve selected one or more recipients and specified the subject, the send format, and
records to send, click ‘Send’ or ‘OK’ to initiate the send process. Informed Filler creates a file
taining the record, or records, you specified and attaches it to the e-mail message for transm
to the recipient. You’ll see a progress dialog as sending proceeds.

Selecting a Suggested Route

If the form template you’re using has one or more suggested routes defined, choosing Send d
a different dialog box.

Data Format Description

Informed data

Informed package

Informed Inter-
change

Tab and comma 
delimited text

Informed data is Informed’s own proprietary format for storing form data
Each Informed data document is a database that contains all the data f
one or more records. Use this format when mailing forms to another us
who already has the appropriate template needed to view the data. Thi
the most common data format to use when sending forms.

Informed package contains both the data and template for a form. Use t
format if the person you are mailing the form to doesn’t have the approp
ate template needed to view the data.

Informed Interchange files contain the data for one or more records and
are used primarily for transferring information between different applica
tions, and different versions of Informed Filler.

The delimited text file format is a standard format that’s used primarily fo
transferring information between Informed Filler and other applications.
Use the Comma or Tab delimited text formats when mailing forms to 
someone who needs to import the data into another application such as
spreadsheet, word processor, or another database.

Note When Informed Filler creates the file that is attached to the e-mail message, it names the fi
according to the filename.ext format of DOS filenames. That way if the recipient of the form, o
forms, uses a Windows compatible computer, the file attachment will have the correct file 
extension for use with Informed Filler.
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A suggested route is a named step in the processing of a form. The route name is intended t
tify the step and instruct the user as to where the form should be sent. For example, a time c
form might be filled out by an employee, sent to a manager for approval, and then forwarded
payroll department. To make it easy for each person in the process to know where to send th
next, suggested routes named “Send To Approving Manager” and “Send to Payroll” could be 
to the form template. Also included with each suggested route are send parameters such as
names of recipients and a subject for the mail message.

You specify which records to send by selecting an item from the ‘Send’ drop-down list.

To send to a suggested route, simply select the route, then click ‘Send.’ If the suggested rout
fully specified (that is, it includes one or more recipients), Informed Filler automatically sends
record or records.

If no recipients have been specified for the suggested route, Informed Filler will display the S
dialog box for the mail system used by the route. After you select one or more recipients, clic
‘Send.’ When the send process completes, Informed Filler displays a dialog box asking if you’
to save the recipient(s) you specified with the suggested route. If you click ‘Yes,’ you will not 
to specify the address(es) for that particular suggested route again.

Even if the form template has one or more suggested routes, there might be instances where
want to send the form to someone or some place else. For example, if the supervisor you no
send forms to is away on vacation, you might want to re-route your form to his or her manag
instead. Click the ‘Re-Route’ button on the Send dialog box to specify a different address. Ag
the Send dialog box specific to the mail system you use appears, allowing you to address an
your form.

Mail Cells

To aid in addressing forms and specifying various send options, the form designer can take a
tage of mail cells. A mail cell is a cell whose value is used to specify a send option or parame
For example, when you mail a form, Informed Filler looks for a cell named ‘Mail Send To.’ If s
a cell exists, the form is automatically addressed to the name in that cell.
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Other mail cells can be used to automatically enter other parameters such as the subject, wi
mation on the form. The following table shows the four mail cells supported in Informed.

Mail Cells

By calculating a mail cell, the form designer can have a formula automatically check for diffe
conditions and automatically set certain parameters accordingly. For example, if a purchase 
form needs to be sent to a supervisor for approval, the form designer could calculate the ‘Mai
To’ cell so that the recipient of the form is based on the value of the purchase order.

Form Tracking

If the form designer has configured the form template to automatically track forms, Informed F
will connect to the tracking server after the send process completes. Depending on how form
ing was configured, you may be requested to enter information, such as your name and pas
when this occurs.

For more information about form tracking, see Chapter 11, “Form Tracking.”

Adding, Changing, and Removing Suggested Routes
Informed Filler allows you to define your own suggested routes for your form templates by us
the Preferences command.

Choose Preferences... from the Edit menu. When the Preferences dialog box appears, click th
Mail icon in the scrolling list. The dialog box changes to show the Mail Preferences panel.

Mail Cell Description

Mail Send To

Mail Subject
Mail Comment
Mail Enclosure

The name of the mail recipient. The value in this cell must identify a valid us
in the directory of your e-mail system.
The subject of the mail message.
The body of the mail message.
The filename of the enclosure sent with the mail message.

Adding, Changing, and Removing Suggested Routes
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To access the controls for defining a suggested route, click the ‘Suggested Routes...’ button.
Suggested Routes dialog box appears.

The Suggested Routes dialog box contains various controls for editing suggested routes, an
scrolling list showing any suggested routes that are already configured.

When you click ‘Add,’ the Suggested Route Details dialog box appears.
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Type the name of the route in the ‘Route name’ text box. It is helpful if the route name describ
actual step in the routing process.

Specify the mail system to use by clicking the ‘Mail system’ drop-down list and making a sele
from the available choices. The choices in the ‘Mail system’ drop-down list correspond to the
Informed mail plug-ins you have installed in your plug-ins folder.

To specify a recipient, click the ‘Address...’ button. If you have the appropriate e-mail software
installed, Informed Designer displays the Send dialog box for the selected mail system. Simp
select one or more recipients by using the controls on the addressing dialog box.

While the addressing dialog box is displayed, you can also specify a subject for the form, and
the data format that the form will be sent in.

To edit an existing suggested route, select it in the scrolling list on the Suggested Routes dia
box, then click the ‘Modify’ button. The Suggested Route Detail dialog box appears, allowing
to change the specific details for the selected route.

To remove a suggested route, select it in the scrolling list, then click ‘Remove.’

You can change the order of suggested routes in the scrolling list by clicking a route and drag
either up or down with the mouse.

Note If the form designer has locked the data format to be used when mailing the form, that data
mat will take precedence over the one you specify for a suggested route.
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